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What is Select Street Atlas?
Select Street Atlas is a comprehensive digital street map of the United States that is indispensable for 
both business and home use.    Create and print customized maps of any part of the country ¾ for 
planning business trips or vacations, for locating potential or existing customers, or to help your 
customers find you!    And unlike other mapping programs on the market, with Select Street Atlas' friendly 
licensing terms, you can make practical use of the maps you create.

The software lets you:

Locate any place in the country quickly and easily

Find and identify individual streets anywhere in the United States

Create customized maps by adding your own information, including customer lists

Add directions, place text, highlight routes, locate customers, and identify houses and businesses

Print detailed maps in dozens of scales in black & white or color

Choose from a database of 1 million important business, travel, and personal destinations and 
add them to the maps.

Automatically add listings to the maps from any database of your own that includes 9-digit ZIP 
codes, including your address book, customer list, or prospect database

Add information to maps from Pro CD's extensive line of electronic telephone directories



Map Reproduction Rights
Select Street Atlas gives you the power to customize and produce an unlimited variety of maps.    And 
while Pro CD authorizes you to use these maps in many ways ¾ both personally and professionally ¾ 
they are copyrighted.    These maps are not clip art and they are not public domain maps.    As such, they 
may only be used according to the terms of the Select Street Atlas License Agreement.

This section gives a summary of the rights you have to use these maps, as well as some of the uses 
which are not allowed.    For specific information, please see the License Agreement included with the 
User Guide and on-line help.

Authorized Uses

You may reproduce paper maps for a wide variety of non-commercial uses.    Maps that you publish in 
paper periodicals have the following limitations:

No map illustration may be larger than 8.5 inches by 11 inches

No single issue may contain more than five illustrations

The periodical publication may not be an atlas or collection of maps

You may also reproduce paper locator maps in flyers, brochures, reports, appraisals, and catalogs for 
distribution at no extra charge, subject to the following limitations

No distribution may occur in quantities exceeding 5,000 copies

No single issue may contain more than five illustrations

The distribution shall not constitute a publication for sale or contain paid advertising

You may use map displays and print-outs in presentations, subject to the limitation that they are not 
distributed over any electronic media, such as television, videotape, or coaxial cable.    You may modify 
maps and export them into other compatible software, so long as the required copyright notices are 
included on each copy or print of the map.

Copyright notices must be clearly displayed on any reproduction or adaptation made, and modifying the 
base maps does not affect the copyright of these maps.

Non-authorized uses:

Maps produced with Select Street Atlas may not be sold, nor may they be used in any of the following:

Books

Commercial Software

Multimedia kiosks

Displays on commercial, public, or private on-line services, bulletin boards, or the Internet

Clothing, textiles, wallpaper, or other paper products or similar commercial materials

Maps or globes for sale in commercial distribution (including sheet maps, posters, prints, atlases, 
or collections of maps or directories)

More Information:

If you are in doubt about the legality of a proposed use of a map, please call Pro CD at 508-750-0055.





A Family of Products from Pro CD
Select Street Atlas is part of a complete family of products from Pro CD.    Each product contains its own 
data and searching capabilities.    Look for these Pro CD products for your business needs:

Select PHONE DELUXE

U.S. business and residential listings on six CD-ROM discs, Free Phone (one disc), plus a bonus 
business listing disc, and free update

Listings may be searched by name, street address, city, state, ZIP code, telephone number, and 
business type or SIC code

Select PHONE

U.S. business and residential listings on six CD-ROM discs

Listings may be searched by name, street address, city, state, ZIP code, telephone number, and 
business type or SIC code

Net PHONE

All of the data, searching and downloading features of Select Phone, Home and Business Phone,
and Free Phone, plus a bonus business listings disc, all packaged for use on networks by up to 5,
10, 25, or 50 seats

Listings may be searched by name, street address, city, state, ZIP code, telephone number, and 
business type or SIC code

Canada PHONE

Canadian business and residential listings on one CD-ROM disc

Listings may be searched by name, city, province, post code, telephone number, and business 
type or SIC code

Free PHONE

AT&T's nationwide toll free listings on one CD-ROM disc

Listings may be searched by name, address, city, state, ZIP code, telephone number, and 
business type or SIC code.

Home and Business PHONE

U.S. Business and residential listings on three CD-ROM discs

Home Phone listings may be searched by name, then limited by other fields.    Business Phone 
listings may be searched by name or any portion of telephone number, then limited by other 
fields.

Home PHONE

U.S. residential listings on two regional CD-ROM discs

Listings may be searched by name, then limited by other fields

Business PHONE

U.S. business listings on one CD-ROM disc



Listings may be searched by name or any portion of telephone number, then limited by other 
fields

Canada Home PHONE

Canadian residential listings on one CD-ROM disc

Listings may be searched by name, then limited by other fields

Pro CD Fax BOOK

Published U.S. and Canadian fax numbers on one CD-ROM disc.    Bundled with Delrina WinFax 
Lite for Windows

Listings may be searched by name, address, city, state/province, ZIP/post code, fax number, and 
business type or SIC code

For more information: 

Call us at 1-800-99-CDROM

Fax us at 508-750-0070



Find a particular place
Select Street Atlas contains maps showing nearly every street in the United States and a large database 
of important places and features. This geographic information can be viewed at ten different levels 
ranging from the most general ¾ where the United States fills the entire screen ¾ to the most specific, 
where only one or two miles fill the entire screen.

The easiest way to find a particular place in this atlas is to use the Find option, accessible from either the 
Edit menu or the Tool Bar.    Find allows you to specify a particular area by entering a state, a city/place 
(town, village, major park, airport, university, or point of interest), county, area code/exchange, ZIP code, 
or street.    To find a street, you must first go to the map of the general area by finding a place, ZIP code, 
or area code/exchange.    

If you know the location of the place you want to find, you can always use the cursor, while in Navigate 
mode, to zoom quickly to that part of the map and double click to zoom in from there. 



Move around the map
Select Street Atlas is designed to allow you to move around the geographic atlas quickly and easily.    You 
can change the area you are viewing by:

1. Bringing the general area you're looking for onscreen by using either the Find option or by using 
the Navigate cursor to zoom to a particular area. 

2. Removing detail from the map and viewing a larger area by using the Zoom Out button, or 
selecting a higher level in the Map menu once in the general area.    You can add detail to the 
map and view a smaller area by using the Zoom In button, or selecting a lower map level.

3. Moving the map sideways or up and down by clicking on the scrollbars (see View menu).    Or, if 
you are in Navigate mode, you can simply click on the map to center it on that point.    

HINT: You can save a particular map for recall in the future by using the Save option in the File menu or 
Tool Bar.



See a map of Alaska or Hawaii
There are three ways to access maps of Alaska and Hawaii:

1. Use the Find option to select the state, a city, ZIP code, or telephone area code and exchange 
within the state.

2. Use the cursor while in Navigate mode to zoom to a particular area by dragging a rectangle on 
the Alaska or Hawaii insets in the National level map.

3. Select Alaska or Hawaii from the Map menu.

Because these states are not part of the continental U.S., you cannot use the scrollbars to move there 
from other states.

There are no Regional or Multistate map levels for Alaska or Hawaii.    Also, at the lower geographic 
levels, oceans are not filled with blue.



Customize a map
Select Street Atlas allows you to customize the standard atlas map in four ways:

1. Drag Symbols onto the map and label them with text of your choice, or add a text block alone.    
Use this option to mark businesses or your home, to add specific directions, or to label features 
not automatically labeled by the software.

2. Selectively add important Places to the map.      Select Street Atlas contains the locations of more 
than a million business locations ¾ hotels, restaurants, stores, sports facilities, travel and local 
services, and more.    The software allows you to add these either by category or individually.

3. Import your own listings and display them on the map.

4. Highlight particular streets on the map.    Use this option if you want to use the map to give 
directions.

Store any annotations you make by using the Save... or Save As... options from the File menu or Tool 
Bar.



Identify unlabeled features
Select Street Atlas automatically determines which features to label so that the map is not cluttered. 
Sometimes, the name of a particular street does not show on the map because there is not enough room 
to automatically draw the label.    

Change to Identify mode to reveal the name of unlabeled features in the status bar.    You can identify:

1. Streets

2. Places

3. Symbols/Listings



Add Locations to the Map
Select Street Atlas includes software that locates addresses on a map based on either latitude/longitude 
coordinates or a ZIP+4 postal code.    Use this feature to map any database that incorporates 9-digit ZIP 
codes, including customer accounts, your address book, or lists from any Pro CD telephone directory or 
other external database.

You can import up to 2,500 listings per session.    

To import your listings you must have a comma-separated text file containing either of two sets of 
information:

· Latitude, Longitude, and Name

· Name, Address, City, State, and 9-digit ZIP code

See the Import section for more information on loading your data.

Related Topics:
File Formats for Imported Data
Preparing Addresses in Select Phone
Appending ZIP+4 Postal Codes to Your Database



File Formats for Imported Data
The following are samples of the two valid Select Street Atlas import file types.    In order for the files to 
import properly, the files must be comma-delimited text files with the fieldsin the order shown below.    

Latitude/Longitude

Fields included:    

"latitude","longitude","name"

Notes:

The fields must be in the order given above.    If your fields are in any other order, they will not 
load properly.

Both latitude and longitude must be in decimal degrees format rather than degrees, minutes, & 
seconds.

Only the first 30 characters of the listing name will be shown on the map.

Additional fields, if included after "name" in the file, will be ignored.

See the file PARKS.TXT in the \MAPDATA sub-directory for a sample of this file format.

Quotation marks are optional.

Sample:

"38.893980","-77.041373","Dar Museum General Information","1776 D St 
Nw","Washington","DC","20006-5303","202-628-1776",""

"38.896047","-77.026249","Ford's Theater National Park Service House Whe","511 10th St 
Nw","Washington","DC","20004-1499","202-426-6830",""

"38.886970","-77.025513","National Museum Of African Art","950 Indep Av 
Sw","Washington","DC","20004","202-357-1300",""

"44.837669","-67.033052","Lubec Municipal Airport"

"71.286156","-156.762369","Wiley Post Will Rogers Mem Airp"

"19.445393","-155.891677","Ho'okena Elem-Inter School"

ZIP+4 Address Format

Fields Included:    

"name","address","city","state", "9-digit ZIP code"

Notes:

The fields must be in the order stated above.    If they are in any other order, your file will not 
import properly.

Only the first 30 characters of the listing name will be shown on the map.

Additional fields, if included after 9-digit ZIP code, will be ignored.

For faster loading, sort your address file by 9-digit ZIP code before importing your addresses.

See the file AMUSEMNT.TXT in the \MAPDATA subdirectory for a sample of this file format.

Quotation marks are optional.



Sample:

"Anheuser-Busch Theme Park","104 5th Ave","Carnegie","PA","15106-2302"

"Dorney Pk & Wildwater Kingdom","3830 Dorney Park Rd","Allentown","PA","18104-5803"

"Enchanted Forest","10060 Baltimore National Pike","Ellicott City","MD","21042-3612"

"Busch Gardens Williamsburg","1901 N Moore St","Arlington","VA","22209-1706"



Preparing Addresses in Select Phone
This section gives you directions on how to export listings from Select Phone (or any other Pro CD 
telephone directory that allows export) so they can easily be imported into Select Street Atlas.

1. In Select Phone, build the list of addresses you wish to add to the map using Select Phone's 
search and tag features. (See Select Phone documentation for information on how to do this.)

2. To be sure that your list only includes addresses with 9-digit ZIP codes, press the Zip button in the
Select Phone Main Display window.

3. Select Only listings with ZIP+4 in the Zip Code Limiting Mode dialog box, and press OK to 
return to the Main Display window:

 

3. From the Select Phone File menu, select Export... to display the Export dialog box:

4. Under Format, select ASCII (1995 edition 2.0 or earlier) or ASCII comma-delimited (1996 
edition 1.0).    In 1996 edition 2.0, choose the Select Street Atlas format.
5. Press the Customize button to display the Customize Export    dialog box:



6. Make sure that the first five fields (Name, Address, City, State/Province, ZIP/Post Code) are 
selected.    Other fields can also be selected, but will be ignored by the Select Street Atlas import.

7. Do NOT check either of the two options to separate first and last name or to separate address 
components.

8. Press OK to confirm your changes.    You will be returned to the Export dialog box.

9. Select the Items to be exported:

Highlighted Entries will export only those listings that are selected in the current Select Phone 
window.

Tagged Entries will export only those listings that have been "tagged" in Select Phone.

All Matching Entries will export every listing in the current Select Phone window.

10. Press OK to present the Save As dialog box and select a location for your export file:

11. You can store the file anywhere on your hard drive, but by default, Select Street Atlas will look in 
the \MAPDATA sub-directory for any files to be imported. 
12. To improve the speed of loading addresses, sort your export file on 9-digit ZIP Code before 



importing it into Select Street Atlas.    Use your favorite database management software to sort the file.



Appending ZIP+4 Postal Codes to Your Database
9-digit postal codes are required for importing addresses into Select Street Atlas.    Most Pro CD 
telephone directory listings already have 9-digit ZIP codes and can be readily imported and displayed on 
the map.    See the section on Preparing Addresses in Select Phone for Import for more information on 
exporting Pro CD listings in the correct format.

If you have a database that doesn't include ZIP+4 records, you can purchase a utility program from Pro 
CD that will correct the records and append 9-digit ZIP codes to your database.    For information on 
obtaining this program, call 1-800-99-CDROM.

If you are connected to the Internet, the U.S. Postal Service World Wide Web server allows you to look up
9-digit ZIP codes for business locations.    Access this service at http://www.usps.gov/.



Print a Map
To print a map:

1. Choose Print... from the File menu.

2. The Print dialog box appears on the screen. A map preview shows you the approximate area that 
will be printed.    Note: Words and symbols do not show up on the preview, but will be printed on 
the map.

3. Change the amount of area to be printed by selecting one of the Less or More area buttons.    
The map preview will redraw to show you the area that will be printed.    You cannot change the amount of
area when printing the National map.

4. Enter a map title, if desired.

5. Press Print Setup... to change your printer options (for example, to change from printing the map
in portrait to landscape mode).

6. Press Print to send the output to the printer. 



Undo Changes
The Undo option from the Edit menu allows you to reverse the following actions:

Undo Symbol removes the last symbol dragged onto the map.

Undo Symbol Edit undoes the last change made to a symbol or listing label.

Undo Symbol Delete returns the most recently deleted symbol or listing to the map.

Undo Symbol Move undoes the last change of a symbol position.

Undo Clear Symbols returns all symbols or listings removed with the Clear Symbols option to the map.

Undo Highlight removes the last highlight added to the map.    

Undo Clear Highlights returns to the map all highlights removed with the Clear Highlights option.

Undo Import removes the last set of imported listings from the map.



File menu
The following options are available from the File menu:

New  Use this function to create a new session.    Any existing user-defined information such as Symbols, 
Places, or Highlights will be deleted and the map scale will revert to the National (US) level.

Open... Use this function to open a previously saved map.    You will be prompted with a dialog box with 
the USER directory as the default sub-directory.

Save and Save As...     These options save the current map in a user file so that it can be recalled at a 
future time.    All elements in the main map window will be saved: geographic level, current center point, 
and any Symbols, Places, or highlights you have added to the map.    

You    will be prompted for an 8-character or less name.    The default 3-character extension is SSA and 
the default sub-directory is the USER sub-directory.

Use Save when you want to update a previously opened file.    Use Save As... when you want to create a 
new file.

Import...    allows you to add as many as 2,500 addresses with 9-digit ZIP codes or latitude/longitude 
coordinates to your map from any Pro CD directory as well as from your personal databases.

Print... This option prints the current map area, in either color or black & white, to a wide variety of 
printers.      For more information see the section on how to Print a Map.

Print Setup... This function allows you to change the default print parameters.    Use this option to select 
a new printer, change between color and black & white printing, and to change between portrait and 
landscape printing.

Exit  This function quits the current session and brings you back to the Windows Program Manager.



Edit menu
The following options are available from the Edit menu:

Undo    Use this option to undo the change to the map.    The actual operation to be undone will be shown 
in the edit menu.    For more information, see how to Undo changes.

Copy to Clipboard    This option copies the main map screen to the Windows clipboard. From there, you 
can import it into other Windows applications by using the Paste function. 

Find...    This option accesses the Find dialog box.    For more information see the section on how to Find 
a particular place.

Clear Find Marker  This option removes the flag that is added to the map by the Find function.

Clear Highlights    This option removes all highlights from the map.    You can Undo this action.

Clear Symbols    This option removes all Symbols from the map.    You can undo this action.

Redraw Map    This option redraws the map, removing red lines made by the Identify Street option. 



View menu
The following options are available from the View menu:

Places...    Select Street Atlas contains the locations of more than a million places organized in 20 
categories.    This menu option, valid only at City Overview, City Metro, Street, and Detail geographic 
levels, accesses the Places dialog box.    It gives you control over which of these locations are shown on 
the map.    For more information on how to use this feature see Places.

Show Symbol Labels      This toggle option controls whether the name you entered for a symbol is 
displayed on the map.    By default, Symbol names are displayed (the option is checked in the menu).    
Select this option to suppress the name for your Symbol without deleting the information.    

Show Place Labels    This toggle option controls whether Place names are displayed on the map.    Place
names, by default, are not displayed, since the map easily becomes cluttered.    You can also control 
whether place labels are displayed from the Places dialog box.

Show Map Scrollbars    This option controls whether standard Windows scrollbars are added to the map. 
When you use the scrollbars to navigate around the map, each click in the bar itself will scroll the map 
one screen in that direction; each button press will scroll the map one-quarter screen.

Since you can navigate around the map using the navigation cursor (see the section on how to Move 
around the map), the scrollbars are optional.    Removing the scrollbars will give you slightly more map 
area.    

Show 3D Cased Roads

This option changes the way roads are displayed at the Detail map level.    On by default, it gives a three 
dimensional effect to the roads.    When turned off, roads are displayed with standard casings.



Map menu
Select Street Atlas contains geographic information which can be viewed at 10 different scales, or levels 
of detail.    Options in the Map menu move you quickly through these ten levels.    Most of the options on 
this menu can also be accessed from the keyboard.    See Keyboard Shortcuts for more information.

Note: At all but the first map level ¾ the National map ¾ the amount of geography displayed is dependent
upon the size of your monitor.    The main map is twice as big (four times the area) at a 1024x768 
resolution than it is at a 640x480 resolution.

The following options are available from the Map menu:

Zoom In and Zoom Out move you through the 10 levels of geography one level at a time.    Each 
successive zoom will center on the current map center.    When zooming in, only those areas close to the 
center of the map will be visible when the more detailed level is displayed.    

The National map level displays the entire United States, including Alaska and Hawaii, and is the least 
detailed (smallest scale) map available.    State boundaries and abbreviations are the only geographic 
information displayed. This scale displays about 4,000 miles of area on any monitor resolution.    

The Regional map level displays a portion of the United States.    More detailed than the top level, the 
Regional level adds major cities, parks, rivers, and the Interstate highway system to the map display.    
This map level is not available for Alaska or Hawaii.

The Multistate map level takes a closer (larger scale) view of the Interstate highway system (with road 
shields) and urban areas.    This map level is not available for Alaska or Hawaii.

The State map level adds a great deal more information to the map including US and major State roads, 
populated areas and some cities with population greater than 5,000 .

The Midstate level gives a closer view of a region of the current state, adding county boundaries, more 
cities (over 2,500 population) and more rivers and lakes.

At the County level, almost all important roads and cities are displayed.    In addition, important landmarks
show on the map.

The last four map levels, City Overview, City Metro, Street, and Detail are the map levels that show 
every street.    At these levels, you can add Places and Listings to the map.

The last three options in this menu allow you to choose between the Alaska, Hawaii, and Continental 
U.S. data sets.    See the section on how to See a map of Alaska or Hawaii for more information about 
these data sets.



New

Pressing this button starts a new Select Street Atlas session.    It is the same as selecting New in the File 
menu.    When a new session is started:

· The National level map is displayed.

· Any user information is cleared from memory.    All Symbols, Listings, Places, and Highlights are 
cleared from the map.

If you opened a previously saved file, you will be prompted to save your changes.    Otherwise, the map 
clears automatically, and all user information will be lost.    This option cannot be undone.



Open

Pressing this button is the same as selecting Open... from the File menu.    Use this function to open a 
previously saved "map".    Opening a map will restore the following features:

· Map level

· Symbols, Listings, and Text added to the map

· Highlights added to the map

· Activated Places

· Label status.

The Open dialog box is presented, with the USER directory selected as default.    Select the desired .SSA 
file and press OK to open the file.



Import

Pressing this button is the same as selecting Import in the File menu.    Use this option to load up to 2,500
user listings onto your map.    To use this option, first specify your data file from the Select Import File 
dialog box:

Press OK to load the selected file.    The software will load the first 2,500 records in the file. If there are 
already Symbols or Listings on the map, the software will load listings until it reaches the 2,500 limit.

If your import file already includes latitude and longitude coordinates, the listings will import quickly.    If 
you are importing listings which will be located according to their 9-digit ZIP code, the software will prompt
you to insert CD-ROM Disc #2, Select Places, so that it can access the data on that disc.    Depending 
upon the number of addresses to be imported, this may take a few minutes.    When the geocoding is 
complete, the software will prompt you to reinsert Disc #1, Select Street Atlas in your CD-ROM drive.

Next, you will be asked to select the symbol to be used for all imported listings.    Select a symbol and 
press OK to complete the data import.    Pressing Cancel Import will return you to the map without 
loading any data.

For more information on preparing addresses for import see the sections on File Formats for Imported 
Data, Preparing Addresses in Select Phone, and Appending ZIP+4 Postal Codes to Your Database.



Save

Pressing this button is the same as selecting Save in the File menu.    It saves the current "map" in a user 
file so that it can be recalled in the future.    All elements in the main map window are saved including:

· Map center and level

· Symbols, Listings, and Text added to the map

· Highlights added to the map

· Activated Places

· Label status

If you have saved the file before, the new map information will be written to the file without further prompt. 
Otherwise, you will be presented with the Save As dialog box, and asked to specify a location for the file.   
Select Street Atlas automatically saves files with a .SSA extension.



Zoom In

The Zoom In option changes the main map to a more detailed geographic level, retaining the current 
center of the map.    
You can zoom in by pressing the Zoom In button, selecting Zoom In from the Map menu, or pressing the 
PgDn key. 
Zoom In is not valid at the Detail map level.



Zoom Out

The Zoom Out option changes the main map to a less detailed geographic level, retaining the current 
center of the map.    
You can zoom out by pressing the Zoom Out button, selecting Zoom Out from the Map menu, or 
pressing the PgUp key. 
Zoom Out is not valid at the National map level.



Find

The Find option allows you to quickly find the map for a particular area or identify streets within a 
particular map.    Press the Find button, or select Find... in the Edit menu to display the Find dialog box:

1. Use the radio buttons to select the type of feature to search for.    Options are:

State:    All 50 states plus the District of Columbia

City/Place:    Approximately 150,000 cities, towns, villages, major airports, major parks, major 
points of interest, and major universities.

County:    Counties in the continental United States

ZIP Code: 5-digit ZIP codes with post office names.

Area Code/Exchange: Telephone prefixes for the United States.

Street:    Streets currently displayed in the main map window.    Note: This option is only valid at 
the lower four geographic levels (City Overview, City Metro, Street, and Detail).

2. Type the name of the place you are looking for in the edit field.    The software automatically 
scrolls to the portion of the list containing that name.    The list displays all available information 
about the feature ¾ city names show the county in which the city is located.

3. Select the desired location in the list box.

4. Press the Locate button.

5. Select Street Atlas will redraw the map at the best geographic level for the feature you selected, 
with the feature marked in the center of the screen by a flag.    This find flag will remain at that 



location until you select Clear Find Marker from the Edit menu, find another place, or begin a 
new session.

Finding a Street

To find a street, you must first go to its approximate geographic area ¾ the easiest way to do this is to first
find a city, ZIP code, or area code/exchange.

One street name may show up several times in the street listing.    This is because it is listed once for 
every "square of map data" or grid read from the CD.    This occurs more often for long streets that extend
across multiple grids.

Related Topics:
Hints for Searching



Hints for Searching
Lists in the Find dialog box are always matched alphabetically to the text you enter.    If the place or street 
you are searching for has a compound name, and you do not find the place in the Find list, try entering 
abbreviations.    Commonly used abbreviations are:

N North

S South

E East

W West

St Street

Blvd Boulevard

AveAvenue

Rd Road

SR State Highway

St Saint



Places

This option (only available at the lower four geographic levels) selectively displays business and travel 
locations on the map.    Press the Places button, or select Places... in the View menu to display the 
Places dialog box:

To add places to the map:

1. In the Places dialog box, check the categories you want to add to the map.

2. Check whether or not you want the locations to be labeled.    You can also control this with the 
Show Place Labels option in the View menu.

3. Press Select All to check all categories.    Press Remove All to deselect all categories.

4. Press OK to display the selected places on the map.    Press Cancel to return to the map without 
making any changes.

Select Street Atlas also allows you to individually select which locations are displayed.    Press the 
Listings... button to see the categories of places in the current map area.



Listings

This function allows you to add Places to the map individually.    The Listings dialog box can also be 
accessed from the Places dialog box.    

Follow these steps to add listings to the map:

1. Choose a Places category from the Category drop down list. 

2. Select the location you want to add in the Places in Area list.

3. Press Add to Map to mark the location on the map with a Symbol.    A counter indicates how 
many Symbols have been added.    On smaller screens you will not see the Symbol until after you
close the dialog box.

4. Press Done to close the dialog box. 

After a Listing has been added in this manner, you can move, edit the label or delete it as you would any 
other Symbol after changing to the Identify cursor mode.    A maximum of 2,500 listings or symbols can be
added to the screen in a single session.

Related Topics:
Accuracy of Data



Accuracy of Data
Every effort has been made to provide a comprehensive set of Places in this product.    But, because 
businesses come and go, move, and change name, over time this set will become increasingly 
inaccurate.    If you wish to make a minor change to correct old information, first add it to the map 
individually using the Listings dialog box and then edit or move it as you would a Symbol.

Note: Save your map to store any changes you make.



Navigate

The default cursor mode is Navigate, marked by a crosshair cursor: 
In this mode you can:

1. Click on the map to center it at that location.

2. Double click on the map to center and zoom in one geographic level.

3. Drag a rectangle on the map to zoom to the approximate geographic area defined by the 
rectangle.

The two other cursor modes are Identify and Highlight.



Identify

When you select the Identify cursor mode, the cursor changes to a pointer: 

In this mode you can:

1. Click on a road to see its name in the Status bar.    The selected road is highlighted with a thick 
red line.    This line will remain on-screen until you redraw the map or select the Redraw Map 
option in the Edit menu.

2. Click on a Place to view its label in the Status bar.

3. Click on a Symbol to view its label in the Status bar.

4. Click on a Symbol or Text Box (center) and drag it across the screen to move it. 

5. Double click a Symbol or Text Box (center) to change its label or to delete it.

At the National map level you can only identify and edit Symbols.

The two other cursor modes are Navigate and Highlight.



Highlight

When you select the Highlight cursor mode, the cursor changes to a marker:

Use this option to highlight particular streets or areas on the map:

1. Click on the map to start a highlight.    As you move the cursor, a thin line will be stretched from 
your origin.

2. Click on the map again where you want the highlight to change angle.    The thin line will change 
to a hatched line as you end each segment.

3. Continue clicking the map to add more highlights.    You can scroll the map and continue to 
highlight if you wish.

4. Double click the map or select another option to end the highlight.

Two options in the Edit menu remove highlights:

1. Undo Highlight removes only the last highlights added to the map.

2. Clear Highlights removes all highlights from the map.

Use the Save and Save As... options from the Tool Bar or File menu to save the map with your highlights.

Highlights made at lower geographic levels (City Overview, City Metro, Street, and Detail) do not always 
exactly line up with roads at the higher geographic levels (County, Midstate, State, etc.)    For best results,
always add the highlights at the geographic level you want to display or print.    Highlight mode does not 
work at the National map level.

The two other cursor modes are Navigate and Identify.



Symbols

The Symbols window contains a collection of 100 pre-defined icons that can be used to customize your 
map.    View the entire collection by clicking on the arrow buttons located at the top of the window.    Each 
click of an arrow will scroll the symbols one column.    
Adding a symbol:

1. Scroll to the desired part of the Symbol window.

2. Select a Symbol using the left mouse button.

3. Holding down the mouse button, drag the symbol onto your map.

4. A Symbol dialog box will be presented.    Enter a name or label for the symbol, if desired.    Press 
OK to add it to the map.    Press Cancel to return to the map without adding the symbol.

5. The symbol will appear on the map.    You can turn off the label by deselecting Show Symbol 
Labels in the View menu.

    Adding Text:

1. Drag the text symbol (first in the Symbol window) onto the map as you would any other Symbol.

2. In the dialog box presented, enter the text you want to appear on the map ¾ use the Enter key to 
break lines of text.

3. Press Add to Map. 

Editing a Symbol or Listing:

1. Double click the symbol while in Identify mode.    The Modify Symbol dialog box will be presented.

2. Make any desired changes to the label text and press OK to see the changes displayed on the 
map.

3. Press Delete This Symbol to remove the Symbol from the map.

4. Press Cancel to return to the map without making any changes.

5. Select Undo Symbol Edit in the Edit menu to undo any changes made with the Modify Symbol 
dialog box.

Move a Symbol or Listing:

1. In Identify mode, select a Symbol by clicking on it with the left mouse button. 

2. Holding down the mouse button, drag the Symbol to a new location on the map. 

3. Release the mouse button when the Symbol is in the new location.

4. Select Undo Symbol Move from the Edit menu to return a moved Symbol to its previous location.



Overview

The Overview window shows the area in the main map window ¾ centered in the raised rectangle ¾ in 
the context of a larger geographic area.    
You can use the overview to quickly move to another part of the map.    There are two ways to do this:

1. Click anywhere in the Overview to center the main map at that location.

2. Hold down the left mouse button and drag the rectangular display area around the Overview. The 
rectangle shows the approximate amount of area to be included in the main map.    Release the 
mouse button to redraw the main map at that location.

To show a larger view in the Overview, click the button in the Overview title bar.    The Overview map will 
double in size:

You cannot work on the main map while the Overview is expanded.    To reduce the size of the Overview, 
click the button in the title bar of the expanded overview, or click on the main map.



Legend
The Legend provides you with a key to the various geographic features on your map.    Use the scrollbars 
to move through the different features:

Features in the legend change as you move between the different map levels.    When activated, Places 
are also identified in the legend.



Quick Help
The left half of the Status bar contains quick instructions on how to use the software.    Labels for 
Identified features are also displayed in this portion of the screen.



Scale
A scale bar is displayed in the right half of the Status bar.    This shows the relative scale, in miles, of the 
main map. 



Copyright
Copyright ã 1991-1995 GeoSystems Global Corp.

Copyright ã 1992-1995 Pro CD, Inc.

Copyright ã 1995 Qualitative Marketing Software, Inc.

Copyright ã 1995 United States Postal Service.

All rights reserved. 

This product contains GeoSystems GeoLocateÒ technology and proprietary data sets.    

GeoSystems Global Corp. holds a non-exclusive license from the U.S. Postal Service to publish and sell 
CITY STATE information.    The U.S. Postal Service does not endorse any other portion of Select Street 
Atlas.

GeoLocate is a registered trademark of GeoSystems Global Corp.    Select Street Atlas, Select Phone, 
Home Phone, Business Phone, Free Phone, Canada Phone, Pro Phone, Net Phone, and Pro CD are 
trademarks of Pro CD, Inc.    

Use of the listings, geographic data, and maps contained in this product are subject to the terms and 
conditions of the License Agreement included with the product.



Single User License Agreement
Single User License Agreement

Pro CD, Inc. Compact Disc License/Geographic Database License

All maps and geographic data in Select Street Atlas, including maps you modify, print, reproduce, or 
export, are copyrighted by GeoSystems Global Corp. and listings are copyrighted by Pro CD, Inc. These 
maps are not clip art. They are not in the public domain. Modifying the base maps does not affect the 
copyright of these maps. The maps may only be used pursuant to the terms of this license agreement. 

Please read this license carefully before using the software or accessing the listings, base maps and 
geographic databases contained on the discs. By using the software, listings, base maps and the 
databases licensed to you, you agree to be bound by the terms of this license. If you do not agree to the 
terms of this License, promptly return all copies of the software, listings, base maps and the databases on
the discs, and the User Guide to the place where you obtained it.

1 Grant of License. Pro CD, Inc. ("Pro CD")    grants you a non-exclusive, non-transferable license 
to use    1. directory listings, and geographic data contained on the discs delivered to you by Pro CD with 
this license agreement (the "Listings" and the "Geographic Data"), and    2. the User Guide and software 
delivered to you by Pro CD (collectively, the "Software"), in each case in compliance with the terms of this
License (the Listings, Geographic Data, and the Software are sometimes collectively referred to in this 
License as the "Product"), including the right to install and use one copy of the Product on a single 
personal computer or other microprocessor-based computer having a CD-ROM drive connected directly 
to such computer owned or controlled by you. Listings and Geographic Data may not be accessed over a 
network. You may make a single back-up or archival copy of the Product, as long as you restrict use to 
those purposes and as long as you reproduce all copyright notices included in the product. You may 
transfer the Product from one PC to another, as long as you erase the Product from the old PC before 
loading it onto the new one. You may not copy the Software or all or any portion of the Listings or 
Geographic Data or reverse-engineer, disassemble, or decompile the Product.

2 Map Reproduction Rights. You may reproduce maps in paper periodicals, subject to the 
limitations that (a) no map illustration may be larger than 8.5 inches by 11 inches, (b) no single issue of 
such periodical may contain more than five (5) illustrations, and (c) the periodical publication may not be 
predominantly an atlas or collection of maps. You may reproduce paper locator maps in flyers, brochures, 
reports, appraisals, and catalogs for distribution at no charge, subject to the limitations that (a) no 
distribution may occur in quantities exceeding 5,000 copies, (b) no single issue of such periodical may 
contain more than five (5) illustrations, and (c) the distribution shall not constitute a publication for sale or 
contain paid advertising. You may use map displays and print-outs in presentations, subject to the 
limitation that the distribution not be over electronic mass media, television, videotape, or public coaxial 
cable. You may modify maps and export maps into other compatible software products, so long as all 
copyright notices are reproduced on each copy or print of such modified or exported maps. GeoSystems 
and Pro CD reserve all rights to all other reproductions, modifications, or adaptations of the screen 
displays and map print-outs. This reservation includes but is not limited to: books; commercial software, 
multimedia kiosks, displays on commercial, public, or private on-line services, bulletin boards, or the 
Internet; clothing; textiles; wallpaper; or other paper products or similar commercial materials; maps or 
globes for sale in commercial distribution (including sheet maps, posters, prints, atlases, maps or 
collections of maps or directories). All copyright notices must be clearly reproduced on any reproduction 
or adaptation made.



3 Ownership. The Software, the Listings, and the Geographic Data are proprietary products of Pro 
CD and/or its licensors, and are protected under U.S. copyright law and international treaty provisions. All 
copies of the Software, Listings, and Geographic Data made by you in accordance with this License shall 
contain all copyright notices in the same format and location as such notices appeared on the copy of the 
Product obtained by you from ProCD and/or its licensors. All intellectual property rights in and to the 
Software, Listings, and Geographic Data are retained by Pro CD and/or its licensors. Without limiting the 
foregoing, you acknowledge that (a) neither the Software, Listings, or Geographic Data nor your rights 
and obligations under this License may at any time be sublicensed, assigned or transferred, in whole or in
part, to any third party, (b) you may not distribute, rent, sublicense, or lease the Software, Listings, or 
Geographic Data in whole or in part to any third party except as specifically permitted above in Section 2 
of this agreement and (c) you will not make the Software, Listings, or Geographic Data available in whole 
or in part to any other user in any networked or time-sharing environment, or transfer the Listings or 
Geographic Data in whole or in part to any computer other than the PC used to access the Listings and 
Geographic Data. 

You further agree that you will not make any copy of the Software, Listings, or Geographic Data or any 
portion or derivative work thereof and sell, license, rent, loan, lease or distribute the same to any third 
party except as explicitly permitted under this Agreement.

4 Term. This License is effective upon receipt by you of the Product and shall continue until 
terminated. You may terminate this License at any time by returning all copies of the Product, and any 
portions thereof, to Pro CD. Pro CD may terminate this license immediately and without prior notice if you 
breach any term of this License. You will erase all memory resident copies of the Product and return all 
existing copies of the Software, Listings, and Geographic Data, and any portions thereof, to Pro CD on 
termination of this License, or destroy the same and certify in writing to Pro CD that you have done so.

5 Limited Warranty. Pro CD warrants that all disc(s) on which the Product is furnished shall, for a 
period of 90 days from delivery (the "Warranty Period") be free, in normal use, from defects in material 
and workmanship. Pro CD will have no responsibility to replace any disc(s) that have been damaged by 
accident, abuse, or misapplication. If, during the Warranty Period, a defect in the disc(s) appears, you 
may return the disc(s)    and User Guide to Pro CD for either replacement or, if so elected by Pro CD, 
refund of your purchase price. Pro CD does not warrant the completeness or accuracy of any information 
contained in the Listings or Geographic Data, or that the use of the Software will meet your needs or that 
its use will be uninterrupted or error free. The foregoing constitutes your sole and exclusive remedy for 
breach by Pro CD of any warranties (express or implied) made under this License. EXCEPT FOR 
WARRANTIES SET FORTH ABOVE, THE PRODUCT IS LICENSED "AS IS," AND PRO CD DISCLAIMS 
ANY AND ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING WITHOUT LIMITATION 
ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, 
TITLE AND NON-INFRINGEMENT. NO PRO CD DEALER, DISTRIBUTOR, AGENT OR EMPLOYEE IS 
AUTHORIZED TO MAKE ANY MODIFICATION OR ADDITION TO THE FOREGOING WARRANTY. 
Some states do not allow the exclusion of implied warranties or limitations on how long an implied 
warranty may last, so the above limitations and exclusions may not apply to you. This warranty gives you 
specific legal rights, and you may also have other rights, which vary from state to state.

6 Limitation of Liability. Pro CD's cumulative liability to you and all other parties from any loss or 
damages resulting from any claims, demands, or actions arising out of or relating to this License shall not 
exceed the license fee paid by you for the use of the Product. Pro CD shall not be liable for (a) any loss of
use of your computer or loss or corruption of data or the costs of system or data recovery, (b) any third 
party claims, or (c) any indirect, special, punitive, exemplary, incidental or consequential damages or lost 



profits, whether based on contract, negligence, strict liability or otherwise, even if Pro CD has been 
advised of the possibility of such damages. 

Some states do not allow the limitation or exclusion of liability for incidental or consequential damages, so
the above limitation or exclusion may not apply to you.

7 U.S. Government Licenses. The Product, the Listings, and the Geographic Data are provided with
restricted rights. Use, duplication, or disclosure by the Government is subject to restrictions as set forth in 
Subparagraph 252.227-7013 (c)(1)(ii) (Rights in Technical Data and Computer Software) of the 
Department of Defense Federal Acquisition Regulations Supplement or Subparagraphs 52.227-19 (c)(1) 
and (c)(2) (Commercial Computer Software - Restricted Rights) of Title 48 of the Code of Federal 
Regulations, as applicable. Contractor/Manufacturer is Pro CD, Inc., 222 Rosewood Drive, Danvers, MA 
01923.

8 Governing Law. This License shall be governed by the internal laws of the Commonwealth of 
Massachusetts, as applied to agreements entered into and to be performed entirely within Massachusetts
between Massachusetts residents. If for any reason a court of competent jurisdiction finds any provision 
of this License, or portion thereof, to be unenforceable, that provision of the License shall be enforced to 
the maximum extent permissible so as to effect the intent of the parties, and the remainder of this License
shall continue in full force and effect.

9 Use of the Product. You agree to use the Product, including the Listings and Geographic 
Database, in accordance with local, state, and federal laws, which may limit your use of the Product, 
including the Listings and Geographic Database, for certain applications such as direct marketing, 
telemarketing, and other uses.

10  FEDERAL AND STATE LAW MAY IMPOSE RESTRICTIONS ON THE ABILITY TO SOLICIT BY 
TELEPHONE OR FACSIMILE. LAWS VARY FROM JURISDICTION TO JURISDICTION. A VIOLATION 
OF SUCH LAWS MAY RESULT IN SIGNIFICANT PENALTIES AND OTHER SANCTIONS. ANY 
PERSON INTENDING TO USE PRO CD PRODUCTS FOR SOLICITATION PURPOSES SHOULD 
CONSULT WITH THEIR OWN COUNSEL TO DETERMINE THE EXTENT, IF ANY, OF PERMISSIBLE 
SOLICITATION ACTIVITIES.

11 Complete Agreement. This License constitutes the entire agreement between the parties with 
respect to the use of the Product, and supersedes all prior or contemporaneous understandings or 
agreements, written or oral, regarding such subject matter. No amendment to or modification of this 
License will be binding unless in documented writing and signed by a duly authorized representative of 
Pro CD.

 Copyright 1992-1995 Pro CD, Inc. Select Street Atlas, Select Phone, Pro CD Fax Book, Home Phone, 
Business Phone, Direct Phone, Home and Business Phone, Free Phone, Canada Phone, Canada Home 
Phone, Pro Phone, Net Phone, Pro CD, The National Telephone Directory on CD-ROM, The New Media 
Telephone Book, and the ProPhone logo are trademarks of Pro CD, Inc.

Copyright 1991-1995 GeoSystems Global Corp. GeoLocate is a registered trademark of GeoSystems 
Global Corp.



Geographic Accuracy
The geographic information in this product is compiled from a variety of public and private data sources.    
There is a vast amount of information in this product ¾ over 30,000,000 street segments ¾ which we 
believe to be largely correct and of high quality.    However, in a geographic database of this size and 
scope, there are bound to be minor errors.    In any geographic area, you may find streets or other 
geographic features which are missing, incorrectly drawn, and/or misnamed.    Should errors be evident in
the maps you make from this product, we suggest that you use Symbols to manually add correct 
information to the map.



Keyboard Shortcuts
In addition to using menu commands or buttons, many Select Street Atlas functions can be accessed by 
keyboard sequences:

Home Goes directly to the National map level 

End Goes directly to the Detail map level 

PgDn Zooms in one map level

PgUp Zooms out one map level

Rt arrow Scrolls main map window right one-half screen 

Lft arrow Scrolls main map window left one-half screen 

Up arrow Scrolls main map window up one-half screen 

Dn arrow Scrolls main map window down one-half screen

Alt-1 Displays the National map level

Alt-2 Displays the Regional map level

Alt-3 Displays the Multistate map level

Alt-4 Displays the State map level

Alt-5 Displays the Midstate map level

Alt-6 Displays the County map level

Alt-7 Displays the City Overview map level

Alt-8 Displays the City Metro map level

Alt-9 Displays the Street map level

Alt-0 Displays the Detail map level

Alt-F4 Quits the application

Ctrl-C Copies the main map to the clipboard

Ctrl-F Accesses the Find dialog box

Ctrl-Z Undo last action (when valid)



Product Support
These instructions assume that you have mastered the basic skills needed to operate Microsoft Windows.
If you are not familiar with Windows, you may wish to review the Windows user's guide before using this 
product. 

If you have questions about Select Street Atlas, you can reach us by phone, fax, or E-mail.    

Help by Phone      You can speak to a Technical Support Representative at 508-777-7766 Monday 
through Friday from 8 a.m. to 6:30 p.m. [EST].    You may also fax your questions to 508-750-0070.

Pro CD Bulletin Board      You can find answers to technical questions on the Pro CD BBS, 508-750-
0077.

Pro CD Internet Address      You can also reach Pro CD at our Internet address:

· For all customer service inquiries: customer.service@procd.com

· For product information: sales@procd.com

· For technical support on all Pro CD products: technical.support@procd.com

You may also reach us on the World Wide Web at http://www.procd.com



Troubleshooting
Resource Error Message
Print problems on HP LaserJet II or HP LaserJet III Printers
Printing on the Canon BJC-4000 Color Printer
Pasting maps to Windows Paintbrush
Location for Places, Listings, and Imported Addresses not accurate.
More than One Place in a Single Location
Using Select Street Atlas in Windows '95



Resource Error Message
Microsoft Windows uses what it calls "resources" for displaying pictures, colors, and fonts, among other 
things.    All applications that run in windows "borrow" these resources from one pool.    Sometimes, if 
applications end without returning the resources to the pool, other applications can not get enough 
resources to operate properly.

You can check the percentage of available resources by selecting the About Program Manager... option 
from the Program Manager Help menu.    If only 35% of the resources are free before running Select 
Street Atlas, you may encounter problems printing and displaying maps.

Closing other applications will free resources.    The other way to solve the problem is to restart Windows. 
This will return the resources to the highest level and allow you to run Select Street Atlas with no 
problems.



Print problems on HP LaserJet II or HP LaserJet III Printers
If you are printing maps on an HP LaserJet II or HP LaserJet III printers, and type is not printing properly, 
select the Print TrueType as Graphics option via in the Print Setup Options dialog box.    

For best printing results, you should be using the latest printer drivers available from HP.



Printing on the Canon BJC-4000 Color Printer
On the Canon BJC-4000, select the Grayscale printing option when not printing in color.



Pasting maps to Windows Paintbrush
Paintbrush in Windows 3.1 does not properly support copying maps from the Windows clipboard.    When 
you paste a map into a Paintbrush file, it looks fine onscreen, but does not save the map palette properly: 
it will be saved as a black and white image.    Maps can be pasted properly into Write, Word, and most 
other graphics programs.



Location for Places, Listings, and Imported Addresses not accurate.
Select Street Atlas uses a process called geocoding to position addresses on the map.    This process 
looks at an address, matches it to a street, makes some intelligent guesses about where along the street 
the address should be, and assigns a geographic coordinate to the location.

The geographic coordinate assigned could be inexact for number of reasons:    The address itself could 
have errors in it; the numbering along the street could be non standard; the street could be missing 
information about address ranges (which numbers are on a particular segment of the street); the street 
could be missing from the geographic database.

In urban areas, a Place should be mapped within one-half block of its physical location.    In more rural 
areas, the Place may be within 1-2 blocks of its physical locates.

Addresses which are imported into Select Street Atlas and displayed on the map will be positioned less 
precisely than the Places integrated into the map.    This is because they are positioned according to 
ZIP+4 geocode location.    Address ranges are not taken into consideration.



More than One Place in a Single Location
Sometimes Places in more than one category will display at the same map location and the icon used to 
represent them overwrite each other on the map.    This happens when the two Places are either at the 
same address or are close to each other on a street.      Sometimes you will see the symbol for one place 
on the map, but see the name for another place in the status bar when you identify it.    In some areas, 
you may wish to display one Place category at a time to reduce overlaps.



Using Select Street Atlas in Windows '95
Select Street Atlas has been thoroughly tested in Windows '95.    For best results, use the latest printer 
and video drivers available from Microsoft or your hardware manufacturer.



System Requirements
The following is a list of the minimum hardware necessary to run Select Street Atlas:

- 386SX/25MHz computer or faster

- A minimum of 4MB RAM (8MB recommended)

- An MPC-compatible CD-ROM drive

- SVGA Display (256 colors at 640x480 resolution)

- A Microsoft Windows-compatible mouse

- 5 MB available hard disk space

In addition, the following software is necessary:

- MS-DOS 3.1 or later

- Microsoft Windows 3.1 or later

Related Topics:
Using Select Street Atlas on a machine with 4MB RAM



Using Select Street Atlas on a machine with 4MB RAM
If you use Select Street Atlas on a computer that has only 4MB RAM, you must configure Windows 3.1 
with virtual memory (use a portion of your hard disk as RAM).    A minimum 2 MB additional memory is 
required.    To configure Windows select Virtual Memory... from the 386 Enhanced dialog box in the 
Windows Control Panel.    See your Windows documentation for more information.
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